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College of Business 
Eco 309-01W: Economic Forecasting [CRN 81462] 

Syllabus (Fall 2025): 08/25/2025- 12/12/2025 

Professor: Dr. Kishor Guru-Gharana 
Office: BA 208  
Office Hours: Zoom (link will be emailed) 
Phone 903.886.5703 (off); Fax: 903.886.5702  
Preferred Form of Communication: email (24/7 during semester) 
Communication Response Time: within 24 hours 
Class Hours: Web based with occasional pre-announced Zoom classes  

Email: kishor.guru-gharana@tamuc.edu 

Course Description 

This course is designed to investigate the techniques of the forecasting process as applied to 
business, finance, and economics. Experience is gained in using various popular forecast 
methods, developing a causal variable hypothesis for forecasting, and in collecting and analyzing 
data.  

Course Objectives 

1.Students will demonstrate the ability to develop models for forecasting using Minitab and 
Excel software. This involves the evaluation of four popular alternative forecast methods and 
deriving the best forecast from among the methods. 

2. Students will demonstrate the ability formulate causal hypotheses and to use and forecast 
appropriate secondary data to forecast business performance.  

3. Students will be able to compare different forecasting models based on the data pattern.  

4. Students will be able to interpret results generated by computer software. 

Course Requirements 

Software Required: Excel with Analysis ToolPak (Free version) 

To enable the Data Analysis ToolPak in Excel, navigate to File > Options > Add-Ins. Select 
"Excel Add-ins" from the "Manage" dropdown and click "Go". Check the box next to 
"Analysis ToolPak" and click "OK". You can then access the tool under the "Data" tab, in 
the "Analysis" group.  

 

If you're using Excel for Mac, in the file menu go to Tools > Excel Add-ins. 

1. In the Add-Ins box, check the Analysis ToolPak check box, and then click OK. 

mailto:kishor.guru-gharana@tamuc.edu
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 If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to 
locate it. 

 If you are prompted saying “the Analysis ToolPak is not currently installed 
on your computer”, click Yes to install it. 

Prerequisites: (Lvl U ECO 231 Min Grade C or Lvl U ECO 2301 Min Grade C) and (Lvl U 
ECO 232 Min Grade C or Lvl U ECO 2302 Min Grade C) and (Lvl U BA 302 Min Grade C or 
Lvl U GBUS 302 Min Grade C or Lvl U ECO 302 Min Grade C) 

No Textbook required. You will be provided with lecture notes and Zoom class videos with 
solved numerical examples, and other resources through D2L by the Professor. 

Minimal Technical skills Needed: High school algebra; using Excel spreadsheet, Excel 
functions and Excel graphics; using PowerPoint and Data Analysis ToolPak. 

Instructional Methods: The professor/instructor will provide lecture notes.  Also, occasional 
pre-announced Zoom classes may be conducted and will be announced at least by Friday of the 
previous week. In the Zoom class I will teach how to use Excel to solve numerical projects 
related to economic forecasting. After the Zoom class I will upload the recorded video and the 
text used in D2L content section. Questions can be asked in Zoom classes or through email. 

Student Responsibilities/Tips for Success in the Course 
1. Students are expected to:  
a. Read and learn from the Lecture notes/ Instructions and videos provided by the Professor. 
b. Work the assigned homework problems independently.  Submit the homework problems by 
due date as indicated through D2L or as instructed through email. 
d. Pay attention to the regular announcements through D2L and emails. 

2.  This syllabus is tentative for the semester.  It is meant to be a guide.  Certain topics may be 
stressed more or less than indicated in the syllabus depending on class progress, and certain 
topics may be omitted. 

3.  Homework problems are assigned and graded about every three to four weeks. Solution to 
Assignment problems will be provided after grading. You can submit early, but I will start 
grading only after the deadline. You can resubmit before the deadline but I will grade only the 
last submission. 

5.  Detailed Instructions with examples for each Chapter will be provided. 

6. Feel free to ask questions in through email. I am accessible 24/7 even during weekends or 
holidays.  

7. Demeanor: “All students enrolled at the university shall follow tenets of common decency and 
acceptable behavior conducive to a positive learning environment”. See Students Guide Book. 

8.  Attendance Policy:  Zoom Class attendance is not mandatory.  

Grading 
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Grade Component   Points  
Four Assignments (100*4)  400 
Final Exam    400 
Final grade (% score) in the course is the average from the student’s total score (Assignments + 
Final). 
Average Range  Grade 

90%-100%   A  
80%-89%   B  
70%-79%   C 
60%-69%   D 
Below 60%   F 

EXAMS SCHEDULE 

Exam  Starts* Ends** Topics Covered  

Final Exam (7 
hrs) 

8 am Monday, 
 Dec 8th, 2025 

11:59 pm 
Wednesday, 
Dec 10th, 2025 

Comprehensive 

*Uploading will be done in the morning (8 a.m.) of the starting date. The Final has a three-days’ 
window period with time limit once you start the tests. It has a Seven-hour time limit. The Exam 
is a single-take Exam. That is, you must finish the Exam in a single take (one-stretch). 

**Mid-night (11:59 p.m.) of the Last Date. Start well before 5 pm of the last date for the Final. 
You can take the test any day/time from 8 am Monday, Dec 8th, 2025. Once the time passes 
11:59 p.m. of the last date or you have spent the given time limit for the test (whichever comes 
first), the system will kick you out of the test. So, be extra careful about the time remaining while 
taking the test. 

The final Exam is accessed through D2L Brightspace following Activities/Quiz/Exam route. 

Assignments are also accessed through Activities/Assignments in D2L. submit through D2L not 
email. 

myLeo Support 

Your myLeo email address is required to send and receive all student correspondence. Please 
email helpdesk@tamuc.edu or call us at 903-468-6000 with any questions about setting up your 
myLeo email account. You may also access information at myLeo.  https://leo.tamuc.edu 

Learner Support 

The One Stop Shop was created to serve you by providing as many resources as possible in one 
location. http://www.tamuc.edu/admissions/onestopshop/ 

mailto:helpdesk@tamuc.edu
https://leo.tamuc.edu/
https://leo.tamuc.edu/
http://www.tamuc.edu/admissions/onestopshop/
http://www.tamuc.edu/admissions/onestopshop/
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The Academic Success Center provides academic resources to help you achieve academic 
success. http://www.tamuc.edu/campusLife/campusServices/academicSuccessCenter/ 
 

COMMUNICATION AND SUPPORT 
Interaction with Instructor Statement: I generally respond to email questions within 24 
hours. You can email any time (24/7) throughout the semester. 
 

COURSE AND UNIVERSITY PROCEDURES/POLICIES 
Course Specific Procedures/Policies 
Missed examination: Missing Homework Assignment will result in zero score while missing the 
Final will result in grade “F”. There will be no make-up Exam or make-up Assignment. 

Syllabus Change Policy 
The syllabus is a guide.  Circumstances and events, such as student progress, may make it 
necessary for the instructor to modify the syllabus during the semester.  Any changes made to the 
syllabus will be announced in advance. 

University Specific Procedures 
Student Conduct 
All students enrolled at the University shall follow the tenets of common decency and acceptable 
behavior conducive to a positive learning environment.  The Code of Student Conduct is 
described in detail in the Student Guidebook. 

http://www.tamuc.edu/Admissions/oneStopShop/undergraduateAdmissions/studentGuidebook.as
px 

Students should also consult the Rules of Netiquette for more information regarding how to 
interact with students in an online forum: Netiquette 
http://www.albion.com/netiquette/corerules.html 

ETAMU Attendance 
For more information about the attendance policy please visit the Attendance webpage and 
Procedure 13.99.99.R0.01. 

http://www.tamuc.edu/admissions/registrar/generalInformation/attendance.aspx 

http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13stude
nts/academic/13.99.99.R0.01.pdf 

Academic Integrity 
Students at East Texas A&M University are expected to maintain high standards of integrity and 
honesty in all of their scholastic work.  For more details and the definition of academic 
dishonesty see the following procedures: Undergraduate Academic Dishonesty 13.99.99.R0.03 

http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13stude
nts/undergraduates/13.99.99.R0.03UndergraduateAcademicDishonesty.pdf 

http://www.tamuc.edu/campusLife/campusServices/academicSuccessCenter/
http://www.tamuc.edu/campusLife/campusServices/academicSuccessCenter/
http://www.tamuc.edu/Admissions/oneStopShop/undergraduateAdmissions/studentGuidebook.aspx
http://www.tamuc.edu/Admissions/oneStopShop/undergraduateAdmissions/studentGuidebook.aspx
http://www.tamuc.edu/Admissions/oneStopShop/undergraduateAdmissions/studentGuidebook.aspx
http://www.albion.com/netiquette/corerules.html
http://www.albion.com/netiquette/corerules.html
http://www.tamuc.edu/admissions/registrar/generalInformation/attendance.aspx
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/academic/13.99.99.R0.01.pdf
http://www.tamuc.edu/admissions/registrar/generalInformation/attendance.aspx
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/academic/13.99.99.R0.01.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/academic/13.99.99.R0.01.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/undergraduates/13.99.99.R0.03UndergraduateAcademicDishonesty.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/undergraduates/13.99.99.R0.03UndergraduateAcademicDishonesty.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/undergraduates/13.99.99.R0.03UndergraduateAcademicDishonesty.pdf
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Graduate Student Academic Dishonesty 13.99.99.R0.10 

http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13stude
nts/graduate/13.99.99.R0.10GraduateStudentAcademicDishonesty.pdf 

ADA Statement 
Students with Disabilities 
The Americans with Disabilities Act (ADA) is a federal anti-discrimination statute that provides 
comprehensive civil rights protection for persons with disabilities. Among other things, this 
legislation requires that all students with disabilities be guaranteed a learning environment that 
provides for reasonable accommodation of their disabilities. If you have a disability requiring an 
accommodation, please contact: 

Office of Student Disability Resources and Services 
East Texas A&M University, Gee Library- Room 162 
Phone (903) 886-5150 or (903) 886-5835   Fax (903) 468-8148 

Email: studentdisabilityservices@tamuc.edu 

Website: Office of Student Disability Resources and Services 
http://www.tamuc.edu/campusLife/campusServices/studentDisabilityResourcesAndServices/ 
 
Nondiscrimination Notice 
Texas A&M University-Commerce will comply in the classroom, and in online courses, with all 
federal and state laws prohibiting discrimination and related retaliation on the basis of race, 
color, religion, sex, national origin, disability, age, genetic information or veteran status. Further, 
an environment free from discrimination on the basis of sexual orientation, gender identity, or 
gender expression will be maintained. 

Campus Concealed Carry Statement 
Texas Senate Bill - 11 (Government Code 411.2031, et al.) authorizes the carrying of a 
concealed handgun in Texas A&M University-Commerce buildings only by persons who have 
been issued and are in possession of a Texas License to Carry a Handgun. Qualified law 
enforcement officers or those who are otherwise authorized to carry a concealed handgun in the 
State of Texas are also permitted to do so. Pursuant to Penal Code (PC) 46.035 and A&M-
Commerce Rule 34.06.02.R1, license holders may not carry a concealed handgun in restricted 
locations. For a list of locations, please refer to the Carrying Concealed Handguns On Campus  
document and/or consult your event organizer.  Web url: 
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/34Safet
yOfEmployeesAndStudents/34.06.02.R1.pdf 

http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/graduate/13.99.99.R0.10GraduateStudentAcademicDishonesty.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/graduate/13.99.99.R0.10GraduateStudentAcademicDishonesty.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/graduate/13.99.99.R0.10GraduateStudentAcademicDishonesty.pdf
mailto:studentdisabilityservices@tamuc.edu
http://www.tamuc.edu/campusLife/campusServices/studentDisabilityResourcesAndServices/
http://www.tamuc.edu/campusLife/campusServices/studentDisabilityResourcesAndServices/
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/34SafetyOfEmployeesAndStudents/34.06.02.R1.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/34SafetyOfEmployeesAndStudents/34.06.02.R1.pdf
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/34SafetyOfEmployeesAndStudents/34.06.02.R1.pdf
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TOPICAL COURSE OUTLINE / CALENDAR 

Topic  Mode  Date/Due date 
(Class starts on 
08/25/2025)   

Learning Goals  

Introduction to 
Forecasting  

Lectures+ 
Videos 
uploaded in 
D2L 

Week 1 Understand the importance Forecasting and 
overview of Forecasting Methods 

Exploring Data 
Patterns and an 
Introduction to 
forecasting 
techniques  

Lectures+ 
Videos 
uploaded in 
D2L 

Week 2 Learn about Data types and patterns and be 
able to calculate Autocorrelations with 
different lags, use Different forecasting 
techniques; and calculate Different Measures 
of Forecast error 

Moving 
Averages and 
Smoothing 
Methods  

Lectures+ 
Videos 
uploaded in 
D2L 

Weeks 3-4 Learn about strengths and weaknesses of 
Naïve models; Averaging method; Simple 
Moving Averages and Double Moving 
Averages and be able to use these models in 
real world examples. Be able to identify and 
calculate systematic Underestimation bias and 
learn how to correct it. 

Assignment 1 

 

uploaded in 
D2L  

By 11.59 pm 
(midnight) on 
Sunday, 
September 21st, 
2025 

 

Exponential 
Smoothing 
Methods  

Zoom 
Lectures+ 
email 
attachments 
+D2L 

Weeks 5-7 Learn how and when to use Exponential 
Smoothing Methods for trend and seasonal 
variation including Holt’s two-parameters’ 
method and Holt-Winters’ three parameter 
methods (Seasonal) 

Assignment 2 

(Single 
Exponential 
Smoothing; 
Holt’s Double 
Exponential; and 
Winters’ Triple 

Assignment 
uploaded in 
D2L 

By 11.59 pm 
(midnight) on 
Sunday, Oct 
19th, 2025 
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Exponential 
smoothing 

Time Series 
Component 
Decomposition 
using Ratio to 
Moving Average 
Method 

Zoom 
Lectures+ 
email 
attachments 
+D2L 

Weeks 8-10 Understand time series Decomposition into 
Trend, seasonal component, and cyclical plus 
irregular components. Be able to calculate 
and forecast Trend lines and measure 
Seasonality Indexes. Be able to derive 
Seasonally Adjusted Data and Forecast using 
Ratio-to-Moving average Model. 

Assignment 3 Assignment 
Uploaded in 
D2L 

By 11.59 pm 
(midnight) on 
Sunday, Nov 
9th, 2025 

 

Simple Linear 
Regression  

Zoom 
Lectures+ 
email 
attachments 
+D2L 

Weeks 11-12 Understand the theory and classical 
assumptions underlying the Regression Line, 
Standard Error of the Estimate and coefficient 
of Determination.  Learn how to use 
regression for Forecasting Y. Understand the 
Decomposition of Variance. Be able to 
perform Hypothesis Testing and Analysis of 
Residuals. 

Multiple 
regression with 
Time Series 

Zoom 
Lectures+ 
email 
attachments 
+D2L 

Weeks 13-14 Understand Several Predictor Variables’ 
model, Heteroscedasticity, Autocorrelation 
and Multicollinearity problems in Multiple 
regression. Learn how to use Excel for 
Multiple regression and be able to interpret 
results. 

Assignment 4 

 

Assignment 
Uploaded in 
D2L 

By 11.59 pm on 
Sunday, Dec 
7th, 2025 

 

Final Exam-time 
limit 7 hours 

One attempt and 
single stretch 
(no break) 
All topics- 
Comprehensive 

Uploaded in 
D2L by 8 am 
Monday, 
December 8 

 

Window period: 
 8 am 
Monday, Dec 
8, to 11:59 pm 
Wednesday, 
Dec 10, 2025 
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